Lesson Five: Create and Modify Reports

1. Click on the Clients Table, then click on Create. Go to the Reports group and
click on Report Wizard.

File Home Create External Data Database Tools Help Table Fields Table L Tell me what you want to do
HE 0 BR EEOBm 1] ] 62 reponvpeos
Application Table Table SharePoint  Query Query Form Blank Navigation ~ Report Report Blank Labels
Parts v Design  Lists ~ Wizard Design Design Form  [EF More Forms ~ Design Report
Templates Tables Queries Forms Reports
- S " g
All Access Obje... © « | = Clents
= p LastName - FirstName - Address -~ City - State » ZipCode -~ County
28arcn..
s e Minna 2371 Jerrold Av Kulpsville  PA 19443 Montgomel
e Gt Berganza Heike 3 Railway Ave{ Little Falls NJ 07424 Passaic
ients
Brideau Junita 6 S Broadway S Cedar Grove NJ 07009 Essex
& ponors Caiafa Ronny 73 Southern Bl Philadelphia PA 19103 Philadelphi

2. Double-click on Last Name, First Name, Home Phone and E-Mail Address; click

Next.

Clients

LastName - FirstName - Address ~ City - State v~ ZipCode -~ County -~ HomePhont~ CellPhone - Email Addre - ¢
Amigon Minna 2371 Jerrold Av Kulpsville PA P T —
Berganza Heike 3Railway Ave i LittleFalls  NJ Report Wizard
Brideau Junita 6 S Broadway S Cedar Grove NJ ‘ Whiich Rekds do you want on your repert?
Caiafa Ronny 73 Southern BI' Philadelphia PA
Canlas Erinn 13 S Hacienda [ Livingston NJ ‘ You can choose from more than one table or query.
Chui Ezekiel 2 Cedar Ave #8 Easton MD |
Corbley Candida 406 Main St Somerville NJ Tables/Queries
Cousey Sylvia 287 Youngstow Hampstead MD Table: Clients 5
Coyier Detra 96950 Hidden L Aberdeen MD
Crupi Delisa 47565 W Grand Newark NJ At fiece
Emard Franklyn 4379 Highway 1 Philadelphia PA Address
Ennaco Teri 99 Tank Farm R Hazleton PA (s:lt;vm
Eroman llene 2853 S Central | Glen Burnie MD Zip Code
Francescon Rolland 2726 Charcot A Paterson NJ g:‘ﬂmptt\‘::ne
Fritz An 506 S Hacienda AtlanticCity NJ fSocial Security Number ] <<
Glick Albina 4 Ralph Ct Dunellen NJ Dos 2 ‘
Gochal Freeman 383 Gundermai Coatesville PA h
Haroldson Cheryl 92 Main St AtlanticCity NJ Cancd Finsh
Hauenstein Fabiola 8573 Lincoln Bl York PA

The Report Wizard gives you the option to organize the data into groups, which is not
something we need to do for this report; click Next.
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3. You have the option to sort the data in ascending order which of the A-Z; choose

Last Name. Click “Next”.

I Clients
LastName - FirstName - Address ~ City
Amigon Minna 2371 Jerrold Av Kulpsville
Berganza Heike 3 Railway Ave { Little Falls
Brideau Junita 6 S Broadway S Cedar Grove
Caiafa Ronny 73 Southern BI' Philadelphia
Canlas Erinn 13 S Hacienda [ Livingston
Chui Ezekiel 2 Cedar Ave #8 Easton
Corbley Candida 406 Main St Somerville
Cousey Sylvia 287 Youngstow Hampstead
Coyier Detra 96950 Hidden L Aberdeen
Crupi Delisa 47565 W Grand Newark
Emard Franklyn 4379 Highway 1 Philadelphia
Ennaco Teri 99 Tank Farm R Hazleton
Eroman llene 2853 S Central | Glen Burnie
Francescon Rolland 2726 Charcot A' Paterson
Fritz An 506 S Hacienda Atlantic City
Glick Albina 4 Ralph Ct Dunellen
Gochal Freeman 383 Gundermai Coatesville
Haroldson Cheryl 92 Main St Atlantic City
Hauenstein Fabiola 8573 Lincoln Bl York

PA
NJ
NJ
PA
NJ
MD
NJ
MD
MD
NJ
PA
PA
MD
NJ
NJ
NJ
PA
NJ
PA

State + ZipCode -~ County - Home Phon¢ ~ Cell Phone - Email Addre ~ S

Report Wizard

What sort order do you want for your records?

You can sort records by four fields, in either
ascending or desc
1 Ascending
2 v Ascending
3 v
4 v
Cancel < Back Einish

4. Choose a tabular layout option; click Next. Click Next again, then click on Finish.

Report Wizard

What title do you want for your report?
Clients

That's all the information the wizard needs to create your
report.

Do you want to preview the report or modify the report’s
design?

@_g’r'e'v.e»i\} !herepovt o
(O Modify the report's design.

s || < =]
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5. From here, you can see what the report will look like as a printed document. Click
on the Close Print Preview button.

File Print Preview L Tell me what you want to do
S = BE =] ™ § 7
= D O DD B B QE=E H a3 X
Print Size Margins | ] Print Data Only Portrait| Landscape Columns Page Zoom | One | Two  More Excel Text PDF Email More Close Print
v v == * | Setup v Page | Pages Pages~ File orXPS v Preview
Print Page Size Page Layout Zoom Data Close Preview
_—
All Access Obje... © « | = cents X [l cuents >
Tables A
2 Clients
2 ponors Clients
53 Employee
Queries S ast Name First Name Home Phone Email Addre
% Clients Email
3 Amigon Minna 215-874-1229
2 Clients Mailing Address
Forms 2 Berganza Heike 973-936-5095 heike@gma
T8 Enter Client Data Brideau Junita 973-943-3423 @

6. Click on the View button down arrow and choose Layout View.

File Home Create External Data Database Tools Help Report Design Arrange Format Page Setup P Tell me what you want to do
\-:‘-‘-*Ii I colors - 'rzf{ Xz L \ = 2]
| C e N\ =1 C v
View Themes 3 Group b Aa D [ﬁ a) (| Ea N\ [:' E] D @J o)
mFontsv & Sort EHIdEDEﬁHS =
— Grouping & Totals Controls
A Report View D « Nj Clients X | [l Clients X
O s T oG S o e I g0 @ ges wgiee W ges @ giee o g e A e @ e Lo S s e ge

} [}é Print Preview
laywtview : = HSE et e e

g € Page

q [g] Design View g S Name [ l £

& Report Header

»

-

7. This view allows you to change the positioning of the columns. Click on the Last
Name column heading, hold down the Shift key, and then click on one of the
names in the Column (Brideau, for example) and then use your mouse to reduce
the width of the column by moving it to the left.

All Access Obje... © « |EH cients X [l Glents >

Tables ;O Clients Shift

=2 Clients
3 Donors
53 Employee

Queries 2 Amigon

Name Home Phone

Name

215-874-1229

Minna
i Coect Evul Berganza Heike 973-936-5095 cike@g

973-943-3423 ibrid Z

i |
A Brideau «junita

Database Design using Access Lesson Five Page 3 of 11



8. Repeat these steps to adjust the width of the remaining three columns, so that it
looks similar to this:

AH ACC@SS ObJe 9 « W '-‘ Enter Client Data X _‘ Enter New Employee X [HCIiT = Employee
Search.. ,O

‘;"é _ ‘ Clients

= [:' Last Name First Name *hone a

= Empl Amigon Minna 215-874-1229 3 on@ya
=5 Task Berganza Heike 973-936-5095 eike@

B8 Task Brideau Junita 973-943-3423 deau@

9. Let’s create a new table by going to the Create tab, go to Application Parts
and under Quick Start, click on Tasks.

File Home Create External Data Database Tools Help Table Fields Table pe;
) == T, 1 E# Form Wizard
HE D PR EROZ
Application Table Table SharePoint Query Query Form Form Blank Navigatiory
Parts ~ Design  Lists ~ Wizard Design Design Form More Forms ~
Blank Forms ries Forms
e — :
P~ e : J a'E ~ | Click to Add ~
V"T 1 Fujj 1 T:] 2 Right ;:I w)
Details Dialog List Media
== %)
gt Tabs
Quick Start L\f
= —
J ' i) v
Comments Contacts | Tasks

10.Click on Enable Content. Double-click on the TaskDetails form

All Access Obje... © «
Search. /O
Tables 2
B8 Tasks
Forms

j YaskDetaiI%
58] TaskDS

Task Details save & New save & Close

»
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File Home Create  External Data

=
View Filter
Undo b ]
A H ACC( Form View Details
Search =] . .
Tables E Layout View eta||s
& Tasks
Forms N Design View
T2 TaskDtwwns
T8 TaskDS

Not Started

Database Tools

11.Click on the Home tab. Click on the View down arrow, then click on Layout View

Help 2 Tell me what you want to do

™

Refresh
All ~

Z l Ascending ’:Lr_’ Selection ~

Zl Descending E’ Advanced ~ IS Save i Spelling *GoTo~

b Select ~
Sort & Filter

Records Find

Save & New Save & Close

12.Go to the Description field, and make it a little longer by clicking on the lower
right side and using your mouse to move the line downward.

3 Task Details

A . | =al
All Access Obje... @ « | =

Search D _
Tables ~ | Task Details
&3 Tasks

Forms

T3 TaskDetails

=] TaskDs

Not Started

(2) Normal

Save & New Save & Close
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13.Let’s create a report that summarizes all of the projects. Click on the Create tab.
With the Report Layout tools tab selected, click on Blank Report and choose
Portrait.

File Home  Create
|ﬁ |— [ Show Margins

S22 MG [ print Data Only

External Data  Database Tools Help  ReportlayoutDesign  Arange Format PageSetup 2 Tell me what you want to do

[

Pertiait

[

Page Size Page Layout

All Access Obje... © « |8 TaskDetals

seaen s

O H E

Landseape Columns Page
Setup

Tables

Fan
] TaskDetails
B Taskos

14.Click on “Show all tables”, then click on the plus sign and let’'s add Task Title,
Description, Priority, Start Date and Due Date.

nalData Database Tools Help Report Layout Design  Arrange  Format  Page Setup O Tell me what you want to do
Portrait| Landscape C Pag

Setup

15. Position a mouse to the right side of the description and make it a little wider.
Make sure that all the fields are still inside the border.

Portrait| Landscape C Page
Setup
Page Layout
= B Reportt
Field List
] Fietds
C
-

T The Border
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16.Click on Report Layout Design, then click on Title; and let’'s name it “Project
Report”

nal Data Database Tools Help Report Layout Design  Arrange Format  Page Setup £ Tell me what you want to do
mid D E g

MElAO[J@HRELM ) &2 C bage D1 T

Group [
Hide Detail:
&son (2] ide Detats Numbers (53 Date and

Grouping & Totals Controls Header / Footer Tool:
i“'!..["' < | Il Reportt i
Field List

Project Report

Task Title Jescription riority tart Dat

PS | (1) High 3/7/2022 3/1

New Software | Thy

Training
Policy and New training and materials TBD (2) Normal 5/16/2022 5/17/2022
Procedures
Training

(1) High 2/25/2022 4/29/2022

Tech
Plan Fundin,

17.Click on the place holder on the right side of the report, then click on Date and
Time. Check off the second option under Time; click Ok.

Grouping & Totals Controls Header / Footer

] Task Details Reporti

Project Report

Ti ?
Task Title Description Priority R e
New Software |[The desktop computers to be purchased are the Dell XPS ||(1) High [indude Date
Training models, which comes at a cost of $5,979 (® Wednesday, April 06, 2022
Policy and New training and materials TBD (2) Normal 906"“"'22
Procedures O 4/6/2022
Training [ indude Time
Technology Consulting fee income generates $120,000 in annual (1) High O 11:14:34 AM
Plan Funding |/income. However, we need to reduce travel expenses @ 11:14 AM
by doing more video conferencing. O11:14
Sample:
Wednesday, April 06, 2022
[} 11:14 AM
o1 one

18.Close the Field List, then click on Property Sheet.

nal Data  Database Tools Help Report Layout Design  Arrange  Format  Page Setup £ Tell me what you want to do
o2l B [ S 79
[ n [ E N [Ele a | ol > — AT
Group Lé] Hide Details [} @ A u l—] L (SO ;L’ L ] “;h [ ] Insert Page Title Add Existing Property
& Sort s * Image~  Numbers [ Date and Time Fields Sheet
Grouping & Totals Controls Header / Footer Tools

“8l TaskDetaits X | [l Report1
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19.Click on Sort AZ under Format, then click just outside the Report and make sure
you see “Detail” under Section Type.

Property Sheet
Selection type: Section
Wednesday, April 06, 2022
11:14 AM Detail [v]
Auto_Date
Auto_Header0
3/7/2022 3/11/2022 Auto_Time
3/7/2022 3/11/2022 Description
[Detail
ey DueDate
5/16/2022 5/17/2022 Label0
Label10
Label17
Label24
Label3
PageFooterSection
PageHeaderSection
Poeim it

by

[N

2/25/2022 4/29/202

20.Then click on the Format tab. Under Alternate back color, choose “No Color”.
Close the Property Sheet.

= X
Property Sheet
~ X Selection type: Section ‘»"l
Property Sheet .
Selection type: Section Al Detail v
z
fD'e'ta'II' S Format pata Event Other All
—= o i Alternate Back Color Background 1, Darker 5% (o]
~

Forﬂlat Data Event Other Al
s

AUTO Height

Back Alternate Row s

Can Grow

Can Shrink
Display When
Force New Page

Background Form
Background Light Header
Background Dark Header
Borders/Gridlines

Text Black
Text Description
- Text Light
New Row Or Col Text Dark

Height
Keep Together

21.Then click on the View Tab to go back to Datasheet View. Then right-click on the
Report tab and click Save. Let’'s name it “Project Report”. Close the report.

: = ask Details X Report1 Task Datasheet
All Access Obje... @ « = e iz
Tables 2 Pf’OjE‘("t RGDOT'[ Wednesday, April 06, 2022
B Task 11:14 AM
Forms 2 + Fing it gy " "
Task Title r Due Date
3] TaskDetails
3 = New Software | The desktop computers to be purchased are the Dell XPS ||(1) High 242/303all 3f11/3a3al
CB Taske Training s, which comes at a cost of $5,979 Save As ? X
Policy and New training and materials TBD (2) Normal Report Name:

Procedures Project Report
Training

Technology Consulting fee income generates $120,000 in annual (1) High |I]

Cancel

Plan Funding ||income. However, we need to reduce travel expenses
by doing more video conferencing.
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22.As you input new entries and make changes using the Project form, the report
will also reflect those changes after you open it and click on “Refresh All”. For
example, we can change one of the due dates on the Form and then save it.
When we go back to open the Report, we can click on Refresh All, and see that
due date change made on the report:

Fle Home Create External Data Database Tools Help £ Tell me what you want to do
E [
View E Advanced ~ Rafiaeh
- All~
Undo Views Clipboard F] Sort & Filter rﬂ_E§F‘.sfre:h All
|| ACCE‘SS ObJe P « I 3| Task Datasheet X | I8 Project Report
Search.. ,O
Tables % Project Report
j Tasks
Forms & Task Title Descriptior Priority
BB T1askDetail -
New Software | The desktop computers to be purchased are the Dell XPS ||(1) High
B8 Taskps Training models, which comes at a cost of 55,979
R t 3 =
= ek Policy and New training and materials TBD (2) Normal
[ Project Report Procedures
Training
Technology Consulting fee income generates $120,000 in annual (1) High

Plan Funding ||income. However, we need to reduce travel expenses

by doing more video conferencing.

Exporting a Report

*»GoTo~

I3 Select~
Find

Wednesday, April 06, 2022

11:21 AM
Start Date Due Date
3/7/2022 3/11/2022
5/16/2022 5/17/2022
2/25/2022

1. To export the report as a PDF file, click on the external data tab. Click on PDF or
XPS from the Export group.

File Home Create

New Data [EE’ Linked Table Manager

Source ¥

Import & Link

All Access Obje... @ « |=

Tables A
j Tasks

Forms 2
BB TaskDetails

T8 TaskDS

Reports
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External Data

Database Tools  Help £ Tell me what you want to do

2 Saved Imports E ‘@J @ |j & @J @A((ess

Saved Dataverse Excel Text PD
Exports File orX v

Export

Task Datasheet X lﬂ Project Report  »

Project Report
Task Title Priority
New Software | The desktop computers to be purchased are the Dell XPS ||(1) High
Training models, which comes at a cost of 55,979

Policy and New training and materials TBD (2) Normal
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11:21 AM
Start Date Due Date
3/7/2022 3/11/2022
5/16/2022 5/17/2022
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2. Choose a file location in this case. For this example, let's choose “Open File After
Publishing”. Let’s choose “Standard” and then click “Publish”.

File name: | Project Report

Save as type: PDF

Open file after publishing timize for

Hide Folders

(® Standard (publishinc

Options...

2
oo+ [ren

Cancel

3. To export the report as a text file, you would click on “Text File” under Export.
Change the file name, keep the same file location and checkoff where it says,
“Open the destination file after the exports been completed”. Click Ok.

Project Report

All Access Obje... ©

Tables 2
B Task

Forms

Project Report

3 TaskDetail
& Task
Reports

Id  Project Report

4. Keep the default setting under

Project Report

All Access Obje

Tables

Forms 2

2 Project Report
3 1
=

Reports 2

18l Project Report

Database Design using Access

Wednesday, April 06,

Export - Text File )
Select the destination for the data you want to export
Specify the destination file name and format.

File name:

C:\Users\Shawn Myers\Documents\Project Report Text File Browse..

Specify export options

We will not import table relationships, calculated columns, validation rul

»default values, and columns of certain legacy data types such
a5 OLE Object

Search for “Import” in Microsoft Access Help for more information.
Export data with formatting and layout

[] ‘Open the destination file after the export operation is complete.
Select this option to view the results of the export operation, This option is available only when you export formatted data.

Export only the selected records.

Cancel
N
¢ ‘ H ’ ”, H
Encode ‘Project Report’ As”; click OK.
Wednesday, April 06, 2022
11:25 AM
t Date
(1) Hig Encode 'Project Report’ As ? X
2) Normal | Choose the encoding to use for saving this file: éi}_‘l
(®) Windows (default)
Oms-00s Cancel
1) Higt O Unicode
(ks | O unicode (UTF-8)
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The Report will open in the Windows Notepad application.

) Project Report Text File - Notepad

File Edit Format View Help

Task Title

New Software
Training

Policy and
Procedures
Training

Technology
Plan Funding

Project Report

Description

The desktop computers to be purchased are the Dell XPS
models, which comes at a cost of $5,979

New training and materials TBD

Consulting fee income generates $120,000 in annual income

However, we need to reduce travel expenses by doing more
video conferencing.
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Priority

(1) High

(2) Normal

(1) High

Wednesday, April @6, 2022

11:26 AM
Start Date Due Date
3/7/2022 3/11/2022
5/16/2022 5/17/2022
2/25/2022 5/13/2022
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